


SimCLIM FOR DESKTOP TRAINING EXERCISE

SEA-LEVEL RISE AND
IMPACTS ON THE SUNSHINE COAST


THE PROBLEM

The Sunshine Coast boasts of long sweeping bays with beautiful beaches and expanding coastal developments. The coast is the attractant for the regional population as well as tourists.  One of the major issues of local government and communities is to ensure that long-term development of coastal locations is consistent with conservation and recreational values and is acceptable in terms of any risks due to natural hazards. 

Recently, there has been mounting concern about possible future climate change and, particularly, sea-level rise and the implications for sustainable management of the Sunshine Coast.  One immediate concern is the expanding development at “Sandy Beach”, near Maroochydore, where any threat of rapid coastal erosion in the future could have important implications for land-use planning and management. 

In this regard, you are asked to carry out an analysis of the problem, in three parts:

· Assess the range of projections of future sea-level rise for the Sunshine Coast to the year 2100;

· Assess the low-lying areas potentially at risk to sea-level rise and flooding; 

· Conduct an analysis of the possible changes in shoreline position for a particular segment of Sandy Beach (longitude and latitude: 153.13, -26.70)








PART 1:
PROJECTIONS OF FUTURE SEA-LEVEL RISE

Future changes in sea level need to take into account three groups of factors that operate at different scales:  

· Global:  global-mean projections of sea-level changes due to emissions of greenhouse gases and their effects on heating and expanding the oceans and the melting of glaciers and ice sheets.  Uncertainties in global sea-level projections arise from differences in the rate of global warming (the driver) as well as in assumptions about oceanic and ice responses to that warming. 

· Regional:  sea-level will not change evenly around the world, but will vary from region to region due to differences in the rates of oceanic warming, changes in ocean circulation and other such factors.  These differences are simulated by coupled Ocean-Atmospheric General Circulation Models, but different models show different regional patterns of change.

· Local:  locally, trends in vertical land movement affect relative sea level (that is, the level of the sea in relation to the land) due to various crustal, tectonic and sedimentation processes. These trends need to be included in sea-level projections for the future as well.

Uncertainties in the global, regional and local components of sea-level change make future projections rather wide-ranging. However, local planning guidance for the Sunshine Coast provides some advice in this regard.  

· First, in terms of global projections the preference is to use mid-range to high estimates, on the grounds of “better safe than sorry”. 

· Second, in terms of regional GCM results the scientific advice is to use ‘Ensemble’ projections (compiled as an average of multiple GCMs that represent the full range of uncertainty among the available GCMs). This can also be compared with CSIRO-MK-36 (which shows regional patterns for SEQ that are comparable to the global average) and the NORESM1-ME (adjusted) GCM (which gives a regionally high pattern of sea-level rise relative to the average global value). 
· Third, in terms of local trends, geologists have determined that the land is very slowly subsiding around the Sandy Beach, so relative sea level is rising at the rate of about +0.1 mm/yr.  


YOUR TASK: GENERATE MID-RANGE AND HIGH SCENARIOS OF SEA-LEVEL RISE FOR THE YEARS 2050 AND 2100 FOR THE SUNSHINE COAST REGION. 


Enter your findings into this table:


	Model
parameters:
	Mid Projection
 

	High Projection

	
	Ensemble
RCP4.5, mid climate sensitivity
	CSIRO-MK-36, 
RCP4.5, 
mid climate sensitivity

	Ensemble,
RCP8.5,
high climate sensitivity
	NORESM1-ME (adjusted),
RCP8.5,
high climate sensitivity

	
2050
	
27.14
	
23.69

	
37.76
	
36.71

	
2100
	
62.54
	
54.59

	
115.64
	
111.79



Steps for carrying out the task using SimCLIM:   

SimCLIM has a unique sea-level scenario generator that allows the user to take into account the global, regional and local components of sea-level change.  First, generate the mid-range projection. Select Global from the drop-down menu (far right-side of screen). Then choose the Sea-level rise Scenario Generator option.



Then select in the following order:

Local observed sea-level trend:  Tick the option, enter the value 0.10 and tick “vertical land movement component only” and OK  
Longitude and latitude: 153.75 and -26.75, respectively (click to find closest cell).
GCM pattern:  (CSIRO-MK36)*
Global projection:   RCP4.5 (a mid-range projection of long-term stabilization of greenhouse gas concentrations between 2100 and 215e)
Load Data:  click

Scroll down the results to obtain the mid-range values for the years 2050 and 2100 and enter into the table above.  You can also see a graph of the results by clicking on the graph icon on the right-hand-side of the table.

*   It is also now common practice to use an ‘Ensemble’ scenario of a climate variable, generated from an average of more than one GCM. To try this option follow these steps:
1. Select Global from the drop-down menu on the far right hand side of screen
2. Go to the Tools drop-down menu and select Options, and then the Ensembles tab
3. Click on the ‘Add’ button under the Manage ensembles box
4. Enter an Ensemble name, like Global-SLR
5. Select ‘Sea level change’
6. Click ‘Select all’ GCMs that sea level patterns are available for, and click OK
7. In the next window the new Ensemble will now appear in the Manage Ensembles list
8. Now, when generating a future Sea level rise scenario, using the Sea-level rise scenario generator, select the ‘Ensemble’ option, instead of the GCM option, and then select the Global-SLR ensemble you have created from the list, to complete the scenario generation process.

For the high estimates of sea-level rise, repeat the above steps, with two exceptions:

GCM pattern: NORESM1-ME (adjusted)
Global projection:  RCP8.5 (a high projection for increasing greenhouse gas concentrations between 2100 and 2150)

Repeat this analysis with an Ensemble, and enter your results in the Table.

After you have finished recording all of your results in the Table above, click Close to exit out of the scenario generator.



PART 2:
AREAS POTENTIALLY AT RISK FROM SEA-LEVEL RISE

A rise in sea level implies a greater depth of flooding during storm surges from tropical cyclones. In addition, a higher sea level creates “back-water” effects on coastal streams and rivers, which adds to flood hazards during storms. What are the low-lying areas of the Sunshine Coast, potentially at risk from inundation?

YOUR TASK:  GENERATE A MAP OF THE SUNSHINE COAST SHOWING AREAS THAT ARE ONLY 2 METRES OR LESS ABOVE  MEAN SEA LEVEL. 

Steps for carrying out the task using SimCLIM:   

Close any existing images on the screen. Then select Queensland from the drop-down menu at the far right of the screen. Next, put in the cursor in the middle of the screen and right-click; From the File drop-down menu select Open images.  Use the Browse function and select DEM (which stands for Digital Elevation Model).  Click OK.

It may take a minute for the image to appear. When it does, pull the right-side border of the image to the left in order to get the full image of the Queensland state. 

From the Image drop-down menu, select the Reclass Image option, which looks like this:

 

A box will pop up. For the Number of classes, enter 2.  Change the upper value of Class 1 to a value of 2.  Also change the lower value of Class 2 to a value of 2. Click Reclass. When the image appears, resize by pulling the right-side border to the left (as above).

In order to clearly see the areas at risk, you need to choose a colour that you can easily see. To do this, click on the first number class and click on the colour palette as follows:



Select an easily identifiable colour and click OK.

In order to zoom in on the Sunshine Coast, select the Zoom In function on the main toolbar.




Put the cursor approximately on the coordinates 152.9, -26.00 (the coordinates show up in the top-right corner of the image as you move the cursor over the map) and pull down-right to coordinates 153.25, -27.11. 

You should now have an image of the Sunshine Coast with low-lying areas highlighted.  


This coastal region has been one of the fastest developing areas of Australia. In your opinion, is this growth sustainable in light of the potential increase in risk from rising sea-levels and flooding in the future?

It would appear that there is risk of flooding to low-lying coastal areas, which would only be exacerbated with projected climate change, exposing more of the built environment to flood risk in the future.


PART 3:
SEA-LEVEL RISE AND SHORELINE CHANGE AT SANDY BEACH

As mentioned above, there is concern that sea-level rise could accelerate rates of coastal erosion. A site has been selected for a pilot investigation.  This site is a beach-and-dune system at Sandy Beach characterized by onshore-offshore transport of sediment. Please carry out the following tasks.

TASK (1):  ANALYSE THE TRENDS IN SHORELINE CHANGE UNDER NATURAL VARIABILITY (THAT IS, WITHOUT CONSIDERING GREENHOUSE-GAS-INDUCED SEA-LEVEL RISE).

Steps for carrying out the task using SimCLIM:   

The SimCLIM system contains a model called CoastCLIM that is driven by the sea-level projections produced by the sea-level scenario generator.  CoastCLIM   provides “first-order” assessments of sea-level effects on horizontal shoreline position – i.e. coastal erosion. The model has two important features.  First, it has a time lag and is driven year-by-year as sea-level changes, making it a quasi-dynamic model. Second, it has a random “storm generator” on the assumption that beach and dunes retreat under the energy of storms and accrete during more quiescent seasons and years. These two features allow the model to simulate shoreline behaviour and respond to sea-level changes in realistic ways.  The model parameters have been estimated and entered for the pilot site at “Sandy Beach”. To use the model, proceed as follows:

First, select Queensland from the drop-down menu at the far right of the screen. From the Tools drop-down menu select Run an Impact Model, then select Coastal Erosion and then Run (site).   This will bring up the Coastal impact model user interface.

See the dot on the map? Click on it.  Your model parameters will be automatically entered in the boxes. 



Next, click on the Scenario option and go directly to the following selections:

Sea-level rise scenario: enter Baseline (that is, no greenhouse-gas-induced sea-level rise)
Local observed sea-level trend:  Tick the box, enter the value 0.10 and tick “vertical land movement component only” and OK.

Next, click RUN. Your results will be in the table.  You can see the graph by clicking on the table and selecting Current Shoreline.  This is the output variable that you wish to analyse. [Note: it takes about 20 years (1940-1960) for the model to “warm up” from a “cold start”, so changes should be measured from around 1960 onwards].



· by approximately how much (in metres) does the position of the shoreline vary naturally from year to year and from decade to decade?

Year to year: approx. +/-1m 
Decade to decade by about: approx. -2m difference


TASK (2):  ANALYSE THE TRENDS IN SHORELINE CHANGE UNDER A WORST-CASE HIGH PROJECTION OF SEA-LEVEL RISE. 

Steps for carrying out the task using SimCLIM:   

From the Coastal Model user interface, click on the Scenario option and make the following selections:

GCM Pattern:   NORESM1-ME (adjusted)
Sea-Level Rise Scenario:  (RCP8.5)
Climate Sensitivity:  High
Local observed sea-level trend:  Tick the box, enter the value 0.10 and tick “vertical land movement component only” and OK.


Repeat the above steps, using an ensemble scenario for a high projection of sea-level rise




· With these “high” projections of sea-level rise, how does the rate of shoreline retreat change?

By 2100 there is a projected 4m and 6m more shoreline retreat than under the baseline, respectively, for the NORESM1-ME (adjusted) and the Ensemble, using the RCP8.5 and ‘High’ climate sensitivity.

· How do these two ‘high’ projections differ to the results from the baseline projection above?
As above.

· Any advice for coastal planning and development in light of your findings?

The projections indicate a retreating shoreline in the order to 4-6m in the worst case scenario, which would make infrastructure in this area along the coast more severely exposed to storm surges and sea level rise as well as coastal erosion, which has the potential to affect properties on private and public land. The costs of coastal hard protection and retreat need to be evaluated both in economic and non-economic terms to assess whether these and any potential losses are acceptable to local communities.
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